
In this lesson, you will use advanced 
functions and what-if analyses to 
facilitate decision making. Complex 

worksheets for decision making often 
require advanced functions based on the 
values in other cells. With the criteria IF 
function, you can sum, average, or count 
values when specific criteria are satisfied. 
You can use logical functions to specify 
various criteria in formulas. The PMT 
function can determine the monthly 
payment for a business loan, while the FV 
function can determine the future value of 
investments. 

L E A R N I N G  O B J E C T I V E S
After studying this lesson, you will be able to:

■■ Build formulas with criteria IF functions and 
logical functions 

■■ Use the PMT and FV functions to analyze loans 
and investments

L E S S O N  T I M I N G
■■ Concepts/Develop Your Skills: 1 hr 30 min

■■ Concepts Review: 15 min

■■ Total: 1 hr 45 min

C A S E  S T U D Y:  A N A LY Z I N G  A 
F U N D R A I S I N G  C A M PA I G N
Green Clean works in conjunction with an 
environmental charity to raise funds to support 
environmental responsibility. You have been asked 
to track the fundraising efforts of the charity. 
Additionally, this charity plans to expand its 
operations to a new facility and has asked Green 
Clean to help secure the necessary funding. You will 
set up an Excel worksheet that calculates the loan 
repayment schedule for this facility using the PMT 
function and input variables.

3Applying Advanced 
Functions

E X C E L  2 0 1 3
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38 Excel 2013 Lesson 3: Applying Advanced Functions

Creating Formulas Using Criteria 
IF Functions

Excel provides functions that average, count, or sum cells that meet one or more criteria. 
Because Excel performs the necessary calculations instantaneously, the possibility of making an 
error when using these functions is small. Only cells meeting all criteria are averaged, counted, 
or summed.

Function Syntax
Criteria IF functions all utilize a combination of the same arguments.

FUNCTION ARGUMENTS

Argument Description

Range The cells to be compared with the criteria

Criteria Enclosed in quotation (“) marks, the comparison value, text, or expression using a 
comparison operator, such as =, >, <, >=, <=, or <> (not equal to)

Sum range (Optional) The potential cells to be summed. If this is omitted, the range will be summed.

Average range (Optional) The potential cells to be averaged. If this is omitted, the range will be averaged.

The IF functions have the following structure, or syntax.

FUNCTION SYNTAX

Function Description

SUMIF SUMIF(range,criteria,[sum range])

AVERAGEIF AVERAGEIF(range,criteria,[average range])

COUNTIF COUNTIF(range,criteria)

SUMIFS SUMIFS(sum range,range1,criteria1,range2,criteria2)

AVERAGEIFS AVERAGEIFS(average range,range1,criteria1,range2,criteria2)

COUNTIFS COUNTIFS(range1,criteria1,range2,criteria2)

How the SUMIF Function Works
In the formula =SUMIF(C5:C12,”>=30000”,C5:C12), the range to be evaluated is C5:C12. The 
criterion used to determine if a cell in the range should be summed is the second argument, 
greater than or equal to 30,000. The third argument, sum range, represents the cells that Excel 
will add together. In this formula, it’s the same C5:C12 range.

Note that if the sum range is not specified in a SUMIF formula, the range will be used to 
evaluate criteria and to calculate the result. Therefore, the sum range could have been excluded 
from the above formula with the same result.
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Creating Formulas Using Criteria IF Functions 39

How the AVERAGEIF Function Works
In the formula =AVERAGEIF(C5:C12,”>=30000”,C5:C12), the range to be evaluated is C5:C12. 
The criterion used to determine if a cell in the range should be averaged is the second argument, 
greater than or equal to 30,000. The third argument, average range, represents the cells that 
Excel will average. In this formula, it is again the same C5:C12 range.

How the COUNTIF Function Works
In the formula =COUNTIF(C5:C12,”>=30000”), the range to be evaluated is C5:C12. The 
criterion used to determine if a cell in the range should be counted is the second argument, 
greater than or equal to 30,000. The COUNTIF function does not include a third argument.

How the COUNTIFS Function Works
The formula =COUNTIFS(F5:F12,”Yes”,G5:G12,”Yes”) examines the ranges F5:F12 and G5:G12 
for the word “Yes.” Cells are counted only when the word “Yes” appears in both columns within 
the same row.

Cells that satisfy the 
formula’s COUNTIFS criteria

DEVELOP YOUR SKILLS EX03-D01

Create a SUMIF Function
1. Open EX03-D01-Awards from the EX2013 Lesson 03 folder and save it as EX03-D01-

Awards-[FirstInitialLastName].

2. Display the November worksheet and enter Raised at Least $30,000 in cell A13. 

3. Use Format Painter to copy the number format from cell C12 to cell C13 and then format 
the range A13:C13 as bold.

4. Widen column A to fit the text in cell A13.
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40 Excel 2013 Lesson 3: Applying Advanced Functions

5. Select cell C13.

6. Follow these steps to find the SUMIF function:

A	Click the Insert 
Function button.

B Choose Math & 
Trig.

C Scroll down to 
double-click the 
SUMIF function.

7. If necessary, move the Function Arguments dialog box out of the way of column C by 
dragging its title bar.

8. Follow these steps to specify the SUMIF function arguments:

C Leave the Sum_Range box 
empty because the cells are the 
same as the range.

A Select the range C5:C12 
in the worksheet.

B Click in the Criteria box and type >=30000. 
Excel will add the quotation marks.

 Click OK.

9. Review the completed formula.

10. Save the file and leave it open; you will modify it throughout this lesson.

Using Logical Functions in Formulas
Excel provides several logical functions that allow you to customize criteria when comparing 
data. The IF function provides the basis for many of the formulas used for decision-making. You 
can use the AND, OR, and NOT functions in IF formulas to specify one or more criteria to be 
checked. AND requires that all conditions be met, while OR is satisfied if any one of the 
conditions is met. Excel displays TRUE or performs the specified action when the criteria are 
met. Excel displays FALSE or performs a different specified action when the criteria are not met.
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Using Logical Functions in Formulas 41

IF, AND, OR, and NOT Function Syntax
The logical functions (IF, AND, OR, and NOT) have the following structure.

LOGICAL FUNCTION SYNTAX

Function Syntax

IF IF(logical test,value if true,value if false)

AND AND(condition1,condition2,…) 

OR OR(condition1,condition2,…)

NOT NOT(condition)

The following table outlines the arguments of logical functions.

LOGICAL FUNCTION ARGUMENTS

Argument Description

Logical test The condition being checked using a comparison operator, such as =, >, <, >=, <=, or <> 
(not equal to)

Value if true The value, text in quotation (“) marks, or calculation returned if the logical test result is 
found to be true

Value if false The value, text in quotation (“) marks, or calculation returned if the logical test result is 
found to be false

Condition A logical expression to be evaluated as true or false; one of multiple expressions 
evaluated by an AND function or an OR function

How Logical Functions Work Together
The formula =IF(AND(B5>=25000,B5<=50000),D5,””) is used to explain the function results 
shown in the following illustration.

Formula 
results

Logical test Result if true

Result if 
false

In this formula Excel looks to cell B5 to determine the result to display. If cell B5 is greater than 
or equal to $25,000, and is also less than or equal to $50,000, then the contents of cell D5 will 
display. If the conditions for cell B5 are not met, then a blank space (expressed as quotation, 
quotation) will appear in the destination cell. This is seen when copying the formula to cell F6, 
as shown above.
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42 Excel 2013 Lesson 3: Applying Advanced Functions

Alternatively, the logical test NOT(L5=M5) could be used in an IF formula to ensure that two 
values are not identical. If the value in L5 is not equal to the value in M5, the value-if-true action 
is performed; if the values are equal, the value-if-false action is performed.

IFERROR Function Syntax
The IFERROR function checks a formula for an error. The structure of the formula is 
IFERROR(value,value if error).

The value represents the formula being checked for an error, while the value if error represents 
either the value, text in quotation marks, or calculation returned if the formula result is found 
to be an error. Excel checks formulas and returns the following error types.

ERROR TYPES

Error Type Description Common Cause

#DIV/0! Value is divided by 0 Divisor cell referenced in the formula contains 
0 or is empty

#N/A Value not available Cell referenced in the formula is empty

#NAME? Text in a formula is not recognized Misspelled or nonexistent range name in 
formula

#NULL! Nonadjacent areas referenced in a 
formula

The existence of a space character instead of 
punctuation, such as a comma (,)

#NUM! Invalid numeric value in a formula or 
function

Nonnumeric text in a function that requires a 
numeric argument

#REF! Invalid cell reference The deletion of cell(s) referenced in the 
formula

#VALUE! Incorrect data type used in a formula Cell referenced in the formula contains text 
rather than a value

How the IFERROR Function Works
Adding the IFERROR function to a formula allows you to display a descriptive message rather 
than the error type.

Text cannot be 
subtracted in a formula, 
so the error type is 
shown in the active cell.

The defined error 
message, enclosed 
in quotation marks, 
appears in the active cell.
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Using Logical Functions in Formulas 43

DEVELOP YOUR SKILLS EX03-D02

Use Logical Functions
1. Save your file as EX03-D02-Awards-[FirstInitialLastName].

2. On the November worksheet, select cell F5 and choose Formulas→Function 
Library→Logical→IF.

3. If necessary, move the Function Arguments dialog box out of the way so you can see 
columns B–D.

4. Follow these steps to enter the IF function arguments:

C Type “” (open and 
close parentheses with 
no space).

A Type AND(B5>=25000, 
B5<=50000).

B Select cell D5 in the 
worksheet.

5. Click OK.

6. Use AutoFill to copy the formula in cell F5 to the range F6:F12.

7. Save and then close the file.

Using Flash Fill and the CONCATENATE Function
A new feature in Excel 2013 is Flash Fill, which allows you to quickly create 
modified versions of text entries with similar characteristics. CONCATENATE 
is a function that can be used to combine multiple text entries within a 
single cell.

Flash Fill
You may find it useful to modify text within a worksheet so that portions of the text are copied 
to a new column. For example, when email addresses are listed within a column, you can use 
Flash Fill to insert the account name (text before the @) in an adjacent column. You need only 
type the account name for the first row (when using the Flash Fill button on the Ribbon) or the 
first two rows (when using Excel’s automatic suggestions for filled data), after which Excel 
completes all remaining cells.

FROM THE RIBBON

Data→Data Tools→ 
Flash Fill
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44 Excel 2013 Lesson 3: Applying Advanced Functions

Original data

Flash Fill’s automatic 
suggestions, based on data 
typed in the two cells above

Flash Fill Ribbon 
button

Flash Fill Options 
button

Flash Fill can also be used to combine text from multiple columns (for example, combining first, 
middle, and last names from multiple columns into one column) and to modify text (for 
example, adding dashes to a list of phone numbers to modify them from ########## to 
###-###-####).

CONCATENATE Function
Similar to Flash Fill, the CONCATENATE function can combine existing text within a single 
cell. While it is appropriate to use Flash Fill when you are combining multiple columns of data, 
the CONCATENATE function is a better option when combining text entries from non-adjacent 
locations within a worksheet. The syntax of the CONCATENATE function is 
CONCATENATE(text1,[text2],…).

The CONCATENATE function: =CONCATENATE(A2,” “,B2)

DEVELOP YOUR SKILLS EX03-D03

Modify Text Using Flash Fill and CONCATENATE
1. Open EX03-D03-DataCleanUp from the EX2013 Lesson 03 folder and save it as EX03-

D03-DataCleanUp-[FirstInitialLastName].

2. Type Howard in cell C5. 

3. Select cell C6 and then choose Data→Data Tools→Flash Fill.

4. Repeat the above steps to display First Names within column D.
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Creating Financial Functions 45

5. Follow these steps to use the CONCATENATE function:

	Click OK.

A Select cell G5 and choose Formulas→Function 
Library→Text Function →Concatenate.

B	If necessary, drag the 
Function Arguments 
dialog box below row 5.

C	Select cell B5 in the 
Text1 box.

	Select cell I5 in the Text2 box. 

6. Copy the formula from cell G5 to the range G6:G8.

7. Widen column G to display all the data.

8. Save and close the file.

Creating Financial Functions
Excel provides a wide variety of financial functions that calculate important financial numbers. 
For example, Excel has basic financial functions for determining monthly payments on loans 
and the future value of investments.

PMT and FV Functions
The PMT function calculates the required payment for a loan when you specify the loan 
amount, interest rate, and number of payments you will make. The FV function calculates the 
future value of an investment when you specify the payment amount, interest rate, and number 
of payment periods.

Financial Function Syntax
You may enter financial functions using the Insert Function dialog box or by typing them. You 
may use the actual values or cell references in the formulas. Keep in mind that using the cell 
reference offers more flexibility and is, therefore, preferable. 

GENERIC FORMAT FOR PMT AND FV FUNCTIONS

Function Syntax

PMT (Payment) PMT(rate,periods,loan amount,[future value],[type])

FV (Future Value) FV(rate,periods,payment,[present value],[type])
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46 Excel 2013 Lesson 3: Applying Advanced Functions

The PMT and FV functions can be used when the payment amount remains constant, such as 
with most car loans and fixed-rate mortgages.

PMT AND FV FUNCTION ARGUMENTS

Argument Description

Periods The number of payments (typically made monthly) for a loan or number of deposits for an 
investment

Rate The interest rate for each period of the loan/investment. Although loans are quoted as 
annual rates, payments are usually made monthly. Therefore, divide the interest rate by 12 
in the formula. For example, a 7 percent annual rate would be expressed as 7%/12.

Payment The amount invested in each period. It’s always the same for each period.

Loan amount The amount borrowed

Present value 
(optional)

The starting balance of an investment; not required if the starting balance is zero

Future value 
(optional)

The balance you wish to have at the end of an investment; not required if the balance will 
be zero

Type (optional) Indicates when payments are due. You are not required to enter the default argument 0 
(zero) if payments are made at the end of the period. Enter 1 if payments are due at the 
beginning of the period.

Converting Negative Numbers to Positive
Excel treats payments as money you owe, so the PMT and FV functions display the result as a 
negative number. Placing a minus (–) sign before the cell reference or function name (=–PMT) 
in the formula changes the result to a positive number, which may be more easily understood by 
the user.

DEVELOP YOUR SKILLS EX03-D04

Use the PMT and FV Functions
1. Open EX03-D04-Fundraising from the EX2013 Lesson 03 folder and save it as EX03-

D04-Fundraising-[FirstInitialLastName].

2. In the Loan worksheet, type =B3-B13 in cell B6, 6% in cell B7, and 60 in cell B8.

3. In cell B9, type =-PMT(B7/12,B8,B6).

4. Format cell B9 in Accounting format with two decimal places. 

5. Enter the formula =B9*B8 in cell B14; enter the formula =B14-B6 in cell B10.

6. In cell B15, enter the formula =B13+B14.

7. In the Investment worksheet, enter 0 in cell B5, 2.5% in cell B7, and 36 in cell B8.

8. In cell B6, enter the formula =B3/B8.

9. Select cell B9.
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Creating Financial Functions 47

10. Follow these steps to choose the FV function:

C Scroll down the 
Select a Function list 
and choose FV.

A	Click the Insert Function 
button beside the Formula Bar.

B Choose Financial 
from the Or Select a 
Category list.

 Click OK.

11. Follow these steps to specify the function arguments:

A If necessary, drag the Function Arguments dialog box off the 
range A1:B9.

B Select cell B7 in the 
worksheet and type /12.

C Select cell B8 in the 
worksheet.

 Type a minus (–) sign and 
click cell B6.

 Skip the last two arguments and click OK. 

12. In cell E5, enter the formula =E3*25%.

13. Copy the range B6:B9 to the range E6:E9.

14. Select cell E6, click in the Formula Bar, and edit the formula to =(E3-E5)/E8.

15. Select cell E9 and click Insert Function . 

Book-FC2-EX2013.indb   47 11/15/2013   3:07:12 PM

FastCourse Microsoft Excel 2013 FOR  EVALUATION ONLY: LEVEL 2 of 3 (c) 2014 Labyrinth Learning - Not for Sale or Classroom Use

Labyrinth Learning  http://www.lablearning.com

EVALU
ATIO

N O
NLY



48 Excel 2013 Lesson 3: Applying Advanced Functions

16. Follow these steps to enter optional arguments:

A Type -E5 in the Pv text 
box.

B Type 1 in the Type text 
box.

C Click OK.

17. Change the number of months in cells B8 and E8 to 24.

18. Save and close the file.

Concepts Review
To check your knowledge of the key concepts introduced in this lesson, complete the Concepts Review 
quiz on the student resource center.

Book-FC2-EX2013.indb   48 11/15/2013   3:07:12 PM

FastCourse Microsoft Excel 2013 FOR  EVALUATION ONLY: LEVEL 2 of 3 (c) 2014 Labyrinth Learning - Not for Sale or Classroom Use

Labyrinth Learning  http://www.lablearning.com

EVALU
ATIO

N O
NLY


	Excel 2013 Lesson 1:
	Formatting Cell Contents, Advanced Skills
	Working with Conditional Formatting
	Using Presets and Multiple Conditions
	Creating a Conditional Formatting Rule
	Formatting with Graphics
	The Conditional Formatting Rules Manager

	Naming Cells and Ranges
	Naming Rules
	Creating Defined Names
	Using Defined Names

	Concepts Review

	Excel 2013 Lesson 2:
	Managing Multiple-Sheet Workbooks
	Sorting Worksheet Data
	Sorting by a Single Column
	Sorting Selected Rows
	Sorting by Multiple Columns

	Using Flexible Worksheet Views
	Freezing Rows or Columns

	Printing Multipage Worksheets
	Sizing Options
	Headers and Footers
	Adding a Watermark Image
	Applying a Worksheet Background
	Setting Title Rows and Columns 
	Sheet Options
	Working with Page Breaks

	Using Multiple Worksheets
	Selecting Multiple Sheets

	Linking Cells and Formulas
	Why Link Cells?

	Using 3-D Cell References in Formulas
	Why Use a 3-D Reference?
	Creating a 3-D Reference

	Copying Worksheets
	The Move or Copy Dialog Box
	Copying Formats Between Worksheets
	Paste Options

	Concepts Review

	Excel 2013 Lesson 3:
	Applying Advanced Functions
	Creating Formulas Using Criteria IF Functions
	Function Syntax
	How the SUMIF Function Works
	How the AVERAGEIF Function Works
	How the COUNTIF Function Works
	How the COUNTIFS Function Works

	Using Logical Functions in Formulas
	IF, AND, OR, and NOT Function Syntax
	How Logical Functions Work Together
	IFERROR Function Syntax
	How the IFERROR Function Works
	Using Flash Fill and the CONCATENATE Function

	Creating Financial Functions
	PMT and FV Functions
	Financial Function Syntax

	Concepts Review

	Excel 2013 Lesson 4:
	Performing Data Analysis
	Using Data Analysis Tools
	Goal Seek
	Solver
	Scenario Manager

	Displaying Subtotals
	Sorting the List
	The Subtotal Dialog Box

	Concepts Review

	Excel 2013 Lesson 5:
	Utilizing Graphics and Templates
	Using Illustrations with Excel
	Design Principles

	Inserting Pictures and Clip Art
	Inserting a Picture from a File
	Inserting a Screenshot
	Inserting Clip Art
	Moving, Sizing, and Rotating Images
	Scaling and Cropping Images 
	Correcting Images and Applying Special Effects

	Getting Into Shapes
	Inserting Shapes

	Illustrating with SmartArt and WordArt
	Using SmartArt
	Using WordArt

	Using Templates
	Template Features
	Creating a New Workbook from a Template
	Template Storage Locations

	Customizing Templates
	Creating Your Own Templates
	Modifying Custom Templates

	Concepts Review

	Index



